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This document was made using:
 2.4.0 version of the Axicon Linear Verifier Software for Windows.

This document is copyright to Axicon Auto ID Ltd
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Important information
The Axicon verifier is a high precision opto-electronic device and should be handled 
carefully. Please keep and use the case to protect the verifier when it is not in use.

Only use power and data cables supplied by Axicon as the use of non-approved 
accessories will invalidate the warranty. If the verifier is dropped (or subjected 
to similar misuse) the accuracy of the results may be affected and it should be 
returned to Axicon immediately for servicing.

We recommend that the verifier is factory serviced annually to ensure that it 
remains compliant to ISO/IEC 15426-1. The unit should be returned to Axicon or to 
your approved Axicon reseller for this servicing.

Software updates are always available free of charge, and can be downloaded from 
our website, www.axicon.com
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Introduction
What is in the case.

One or more of the following verifiers:

• Axicon 6100-S verifier with USB cable.
• Axicon 6500 series verifier with USB cable.
• Axicon 7100-S verifier with USB cable.
• Wallet containing this user guide and calibration card.

The Axicon verifier is designed to work with any PC running a version of Microsoft 
Windows currently supported by Microsoft.
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Installation
Software installation. 
The software is called Axicon PC verifier for linear barcodes, and the latest version 
will always be available to download from the Axicon website, www.axicon.com/
downloads. Once downloaded, click Axiconlinearverifier.exe and follow the 
installation instructions after agreeing to the licence terms and conditions. 

At the Custom setup window, the boxes relating to Drivers and Main Program are 
automatically selected. It also provides for optional extra plugins (see page 7). 
After installation is completed you will find the Axicon Verifier directory in Start 
Menu/Programs and a shortcut to the program on your desktop.

The software on a CD is available on request. 

Hardware installation
Plug the verifier into any 
available USB port on the 
computer. For Windows 
7 and above, the drivers 
should be installed 
automatically.

Note: Please follow these 
installation instructions 
in the correct order, 
namely installing the 
software before the 
verifier is plugged into 
any USB port. If the 
verifier is plugged in 
before the software has 
been installed, Windows 
will attempt to find the 
correct drivers for the verifier via the internet, and choose an incorrect option. This 
then causes problems as the software is unable to install the correct driver.
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When you reach the Custom setup window you will see a selection of optional 
plugins. The Drivers and Basic Plugins are selected by default. If you require 
other plugins then simply select one or more of the Extra, Utility, Analysis or 
Pharmaceutical plugins. 

The Axicon Linear Verifier software includes several programs that are installed 
automatically and which are not normally accessed by users. These are programs 
that enable different functions for particular applications. These include Choose 
Language, Inline Verifier, RepGen, Scan File Data Extractor, Verifier Help and Laetus 
Pharmacode software. You can access these via the Windows Start menu, and they 
are in the Axicon Verifier folder. 

Choose Language, explained on page 26, allows you to change the default language 
of the software.

RepGen is used to create reports from sets of Axicon verifier scan files. Instead of 
looking at each scan file individually, you can choose to create one file that includes 
all the data that you want about each verification, and that can be added to as 
each verification takes place. Details about how you set up your report template 
are provided in the Help files of the main software.

Scan File Data Extractor is the precursor of RepGen, and is provided for backwards 
compatibility. 

Verifier Help is all the help information that is normally accessed via the Help 
menu shown on the Command Window of the Axicon Linear Verifier software.

Laetus Pharmacode software used with the 6000 series verifiers (including the 
6000W white light verifier) has been specifically designed to meet the requirements 
for verifying the Laetus Pharmacode within the pharmaceutical industry.
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Holding the verifier
The Axicon verifiers are all designed to be used with the verifier positioned so that 
it touches the barcode, as shown in the pictures opposite. 

Each verifier can be controlled via the software, and they also have a button to 
take a scan. The button on the 6100-S series is on top the read head. The 6500 has 
two buttons on the top. These have the same function so use whichever button is 
more convenient. The 7100-S has a single button on the top of the read head.

Wait for at least a minute after switching on the verifier (when the red LEDs will be 
illuminated) before using it. This allows the circuitry of the reader to stabilise.

It is important that the front flap of the 6500 series verifier is closed so that as 
much ambient light as possible is excluded from the verification process.

If the code you are verifying is printed around the circumference of a curved 
surface, the varying distance of the reader from the code may produce inconsistent 
results.

Press the trigger button. The reader will beep and the data from the first scan will 
be displayed in the software immediately. For full ISO/IEC verification you should 
scan the barcode ten times, moving through its height and avoiding the top 10% and 
bottom 10%.
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The Axicon 6100-S is being placed flat 
onto the label with the barcode in 
the field of view. The 6100-S verifier 
cannot be used for symbols wider 
than 69mm, and this dimension 
includes the quiet zones.

The 6500 series can be operated 
either horizontally or vertically (on 
the side of a carton) but always in 
contact with the barcode. The 6500 
series verifier cannot be used for 
symbols wider than 125mm, and this 
dimension includes the quiet zones.

The Axicon 7100-S is being placed flat 
onto the label with the barcode in 
the field of view. The 7100-S verifier 
cannot be used for symbols wider 
than 200mm, and this dimension 
includes the quiet zones.
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Getting started
When you first start the software you will see the Command window and the 
Summary window. 

Information is also given on the: 
• bar gain (ink spread or bleed), 
• the size of the x-dimension (the width of the narrowest bars)
• validation of the check digit
• structure
• the quiet zones (the clear spaces or light margins each side of the barcode)

The Command window gives access to all of the main features of the verifier. Use 
the pull down menus or the icons to operate the software.

The Summary window shows the overall print quality of the barcode as 
measured in accordance with the ISO/IEC standards.
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Calibration
Calibration should be carried out 
after installation and at regular 
intervals. When the software detects 

an uncalibrated reader the following dialogue 
box will appear Reader XXXX has not been 
calibrated. You must click OK to continue. 
You will also need your calibration card which 
should be located in your documentation 
wallet. 

For the Axicon 6100-S use the EAN-13 
calibration code at the top of the card. For 
the Axicon 6500 series and 7100-S verifier 
use the large GS1-128 calibration code at the 
bottom of the card.

Calibration is a quick and simple process. 
Select Calibrate from the Options menu 
of the command window (or press F2). You 
will see a window with two edit boxes for 
minimum and maximum reflectance values. 
Ensure that the values shown in the window 
match the values printed at the bottom of 
the calibration card. Modify the figures on 
the window if necessary to ensure that they 
are the same as the card.

With the Calibration window open scan the 
calibration barcode 10 times. Then click the 
OK button. The verifier is now calibrated 
and ready to use. After calibration, store the 
calibration card in the documentation wallet, 
away from light and physical damage. If your 
calibration card should ever become damaged or discoloured, please contact Axicon 
or your supplier for a replacement. 

Calibration Card

( )

GS1-128

EAN-13

Serial Number:

This card is NIST traceable

In service date:

Data Matrix

Expiry Date:
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Details
This window shows each of the 
ISO/IEC parameters that are 

measured and individually graded (as 
both grades and percentages). Seven 
parameters are graded and the lowest 
single grade becomes the overall grade 
for that scan. If the Summary window 
has shown poor print quality then the 
Details window is the ideal point to 
initially see what is wrong with the 
barcode.

Scan reflectance profile
The scan reflectance profile window shows you what the barcode will look 

like to a scanner. At the top of the graph are the higher levels of reflectance from 
the background and at the bottom of the graph are the lower levels of reflectance 
from the 
darker bars.

Software windows
There are five more windows you can open to look at the verification results. Go 
to the View menu on the Command window, and the select the window you want, 
or use the icons that appear just below the menu headings. If you hold your mouse 
over each icon a brief description of its function will appear at the bottom left 
of the Command window. The four most important windows are briefly described 
below.
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Dimensional Analysis
If the Details window 
has shown a poor 

Decodability grade then 
this is normally because of 
bad dimensional accuracy 
– this screen will show the 
accuracy of the bar/space 
dimensions and highlight 
any problem areas.

Pass / Fail
This window is ideal 
for users who need 

a quick visual indication of 
whether the barcode meets 
the right print quality 
standards.

Rearranging the windows
Most of the windows described above can be moved, expanded or shrunk as 
required. When you have decided which windows you would like displayed on your 
PC just use the View pull-down menu and click on Save Positions. Then whenever 
the software is started it will always have those windows in those positions.

The help menu from the command window gives you access to context-sensitive 
help about the software. It also has a search function to find relevant information. 
The F1 key can also be used as a shortcut to switch on this help.
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Continuous scan
The Axicon S range verifiers have 
a unique continuous scan feature. 

When first installed this feature is 
automatically activated on start-up (but 
can be de-activated if required) and 
allows the user to get an assessment of 
the barcode quality in a fraction of the 
time that it would take with other linear 
verifiers. 

The verifier should be placed either just 
above or just below the barcode and the 
trigger pressed. With the trigger still 
pressed, move the verifier down the height 
of the barcode. The verifier will scan at 
the rate of 100 verifications a second until 
it reaches the bottom of the barcode (or 
gets to the maximum number of scans). 

The verifier will automatically calculate an 
average of the results of all of the scans 
to provide an overall quality grade based 
upon an assessment across the scanned 
bar height. 

When verifying barcodes on awkward 
shaped packaging you may find it easier to 
switch off the Continuous scan mode. This 
feature can be activated or de-activated 
as required with a toggle switch on the 
Command window.

6100-S

6525-S

7100-S



Page 15 of 32

Axicon Auto ID Limited  |  Linear verifier user guide | April 2025

Axicon 6000, 6500, 7000 series

Selecting the verifier
If you have more than one verifier plugged into your computer at the same 
time (for example a 6100-S and a 7100-S), you will need to choose which one 
you want to use. If the LEDs are not illuminated on the verifier you need, go 

to the Options menu on the Command window, and then choose Show Reader Info 
(or use the shortcut F3).

A new window, Reader info, will appear. 

At the bottom you see the button Enumerate. Click on this and in a few moments 
all the connected verifiers will be displayed as small icons. The first four characters 
are the serial number of each verifier which is clearly marked on each one. Double 
click on the icon for the particular verifier you wish to activate.
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Setup
All of the primary configuration of the verifier is done through the Setup 
section. From the Command window choose Options then Setup or press F5.

General

Standards: Click on ISO if you want only the numeric ISO result to be shown – or 
click on ANSI if you would prefer to be shown both results. The default is to track 
the Windows settings for metric or imperial measurements – alternatively you can 
set this as required. 

Pass Grade: If you are working with GS1 barcodes then the Apply GS1 General 
Specifications should remain ticked. The user can select the pass/fail grade for 
other barcode types as specified either by an industry application specification or 
by their customer.
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Check Characters

This tab allows the user 
to select the barcode 
types that have 
optional check digits. 
If these are being used 
then the verifier can be 
set to validate them.

Appearance

This tab can be used 
to adjust any display 
colours/shades for the 
pass, warning and fail 
messages – and can 
also be used to add 
Windows wave sounds 
to give an audible 
indication of quality.
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Setup
Printing

This tab can be used 
to pre-select any 
particular reports that 
are required. This 
includes the option to 
have a personalised 
report generated 
through the built-in 
Report Generator. 
The verifier software 
can also be set to 
Autoprint to avoid 
forgetting to print a 
particular report. 
 Tick Print graph in black & white if you are using a monochrome (black and white) 
printer, otherwise a scan reflectance profile will only show the outline and not 
the detail. Also, the standard printed report can be personalised if required using 
the Report header 
feature.

Logging

The Logging tab is 
used to set the saving 
of records and to run 
pre-configured external 
programs from the 
verifier.
If the Enable box is 
ticked under the Auto 
Save Scan File section 
(at the top) then the 
software will auto save 
every scan file in the chosen directory. 
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The files saved through this process can be regarded as audit quality records of the 
verifications made and can also be used for remote diagnostics purposes. The files 
can be saved automatically with a filename comprising the decoded number, date 
and time and a sequential number, or by using a dialogue box.

Save File Log allows users to run any Windows program each time a file is saved. It 
is intended for use with RepGen or ScanDB, but could be used to perform any action 
on the saved file.

Simple CSV File allows a subset of the scan information to be automatically 
appended to the specified file in CSV format.

Calibration

The Calibration tab 
specifies the file and 
directory in which 
calibration data will 
be saved. This can be 
altered by clicking 
on the browse button 
and choosing the 
required directory 
and filename. If Allow 
scans after calibration 
has expired is not 
ticked, no scans will 
be allowed until the 
verifier has been calibrated. Within the Allowed Calibration Codes is a list of the 
data content of barcodes with which calibration is permitted
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Setup
Plugins

The Plugins tab 
allows the software 
to be tailored to 
industry specific or 
user specific features, 
such as running 
a product lookup 
database, validation 
of the structure of 
variable weight items, 
or identifying the 
formats of European 
pharmaceutical codes – 
and a whole lot more.
An explanation of what each plugin does is on our website.
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Advanced

There are several 
settings in the 
Advanced tab. If a 
barcode is such a poor 
quality that the verifier 
cannot decode it then 
there is an option to 
manually input the 
barcode under When 
barcode cannot be 
decoded. Use RepGen 
for CSV file save is 
ticked by default: this 
means that simple CSV file saving is performed using repgen.exe and the supplied 
template file csv-template.txt.

The Password for Setup allows password protection of the settings in the Setup 
dialogue. This is useful for ensuring features such as the Pass/Fail grade and file 
saving directories can only be altered by an authorised user. To apply a setup 
password, enter it in the Password for Setup box and click OK. You will be asked to 
re-enter the password you gave. Now, to alter the settings you must enter the same 
password into the Password for Setup again before you click OK. 
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Android app
An app that allows Axicon barcode verifiers to be used with either Android 
tablets or Android smartphones is now available from Google Play. Free 
to use, this app allows anyone with an Axicon 6000, 6500 or 7000 series 
verifier to use it with an Android device, and record the results as easily 

as with a PC or laptop. 

Most users will need to use a USB OTG (on 
the go) adapter for their device, and they 
will need to check which one they require 
to connect to the verifier.

Calibrate
Before any verification scans the verifier 
will need to be calibrated. Calibration 
is achieved in the same way as the PC 
software using the same calibration card. 

Select the menu on the top right of 
the screen and then ‘Calibration’. The 
message below will appear. Scan the 
relevant barcode (see page 11) three times 
and calibration will be complete. 
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The app software is based upon the Axicon PC verifier software, so the results of 
the verification are displayed equally clearly, with the ISO/IEC grade together with 
details of the individual parameters. 

The screen shots below show the data content results displayed at the bottom for a 
GS1-128 barcode.

Swipe from right to left to view each scan. The average result is always shown first.
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Menu
The 3 dot icon on the right hand side of the app will 
display the following menu. ‘Load Scan’ is where any 
previous scans can be viewed and ‘Save Scan’ is where 
individual scans can be saved. ‘Print Report’ can be used 
to save the verification report to PDF. The menu is also 
where you can view the ‘Encodation’ of the barcode. 

‘Show Profile’ option is where you can view the scan 
reflectance profile of the verification scan like on the PC 
software (see page 12). 

‘Clear Scans’ option clears the existing scan; this option 
is also at the bottom of the main screen. For settings 
menu please see next page (page 25). ‘About’ displays 
information about the Android app build details. 

Android app
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Settings
Settings includes these two options, ‘General Application Configuration’ and 
‘Calibration Configuration’. 

General is where you can set number of scans (scan set size), minimum pass grade 
and enable auto save. (The saved scan files records can be transferred to a PC and 
form the basis of any quality control system.) The volume button can be used as a 
trigger and the measurements changed to display imperial units. 

Calibration is where changes to the minimum and maximum reflection values can be 
made to match the calibration card and change the calibration expiry date. 
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Changing the language
The Axicon Linear Verifier (ALV) software will automatically use the computer’s local 
Window system’s locale to determine the language that will be used. If you want to 
change this language, go the Windows start menu (by clicking on the Windows logo 
in the task bar), and find the ‘Choose Language’ software option within the Axicon 
verifier heading. 
You do not need 
to open the Axicon 
Linear Verifier 
software to do 
this.

Click on ‘verifier.
exe’ in the 
central panel, 
and then choose 
the language you 
require from the 
list that appears on the right.

Once you have 
chosen the 
language you 
require, click on 
Set, then close 
this window.  
Now start the 
ALV software and 
you will see that 
the change has 
been made.  If 
you want to see 
the software in English, you will need to click on the ‘Default’ button beneath the 
right-hand panel listing all the language options. Then close this window and re-
start the ALV software.
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Software licence agreement
This software is Copyright © Axicon Auto ID Limited
Use of the software is subject to the Axicon software licence terms set out below. 
Using the software indicates your acceptance of these licence terms. If you do not 
accept these within 14 days, you may return the entire unused product for a full 
refund. 

Axicon grants you a licence to use any number of copies of the software, but only 
for use with an Axicon verifier. “Use” means storing, loading, installing, executing 
or displaying the software. You may not modify the software or disable any of its 
licensing or control features.

Ownership
The software is owned and copyrighted by Axicon Auto ID Limited. Your licence 
confers no title or ownership in the software and is not a sale of rights in the 
software.

Copies
You may only make copies of the software for archival purposes or when copying is 
an essential step in its use. You must reproduce all copyright notices in the original 
software on all copies. You may not copy the software onto a bulletin board or 
similar publicly accessible system.

No disassembly or decryption
You may not disassemble or decompile the software without prior written consent 
from Axicon.

Transfer
Your licence will automatically terminate upon any transfer of the software. 
Upon transfer, you must deliver the software, including any copies and related 
documentation, to the transferee. The transferee must accept these licence terms 
as a condition of the transfer.

Termination
Axicon may terminate your licence upon notice of failure to comply with any 
of these terms. Upon termination, you must immediately destroy the software, 
together with all copies, adaptations and merged portions in any form.
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Export requirements
You may not export or re-export the software in contravention of any applicable 
laws or regulations.

This agreement should be construed in accordance with the laws of England.

DISCLAIMER 
In the following the expression “verifier” means the verifier hardware and the 
associated software.
 
We have taken care to ensure that this verifier is free from defects. However since 
we have no control over the circumstances in which you might use it you must 
satisfy yourself that it is suitable for your needs. Neither Axicon Auto ID Limited 
nor the vendor of this verifier can accept any liability for any loss or damage 
(consequential or otherwise) which may be caused by its use. 

If the verifier or any part of it is defective in any way, or in some other way does 
not meet your expectations, the liability of Axicon Auto ID Limited is limited to the 
cost of the product. You should bear this limitation in mind if you use this verifier 
in any situations where the acceptance or rejection of shipments of goods or your 
reputation may depend upon the quality of a barcode.

Software licence agreement



Page 29 of 32

Axicon Auto ID Limited  |  Linear verifier user guide | April 2025

Axicon 6000, 6500, 7000 series

Warranty
All Axicon products covered by this documentation (Axicon 6000, 6500 and 7000 
series verifiers) are sold with a two year parts and labour warranty against 
manufacturing defects. This is a return to bench warranty with shipping costs in one 
direction being borne by the customer/distributor.

Should you need to return the unit to Axicon the original case (plus appropriate 
packaging) must be used. If the equipment is returned without the original case, we 
will automatically charge an additional sum for its replacement.

Axicon’s standard repair turnaround time is 7-10 working days. This standard 
warranty does not include the provision of a loan unit. Loan units can be supplied 
on request.

Axicon reserves the right to charge an inspection fee for any equipment returned 
under warranty for which no fault is found. Please contact us to obtain an RMA 
number before returning any equipment. This number must be quoted on all 
documentation. We cannot accept responsibility for equipment returned without an 
RMA number.
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Maintenance agreement
A service contract may be purchased within 30 days from the date of despatch. 
This allows you to return your verifier back to us at no extra cost for its annual 
VCAS (verifier conformance and alignment service) so that you can be sure it still 
measures barcode quality in accordance with the requirements of ISO/IEC 15426-1.

The service contract will also extend the warranty beyond two years, so that if it 
breaks down, all parts and labour will be provided free of any extra charges. The 
only exception is when the verifier has been misused, in which case labour costs 
will be covered, but not those of the parts.
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Annual service
All verifiers need servicing every year to ensure that they measure barcode quality 
in accordance with the relevant ISO/IEC standards. This verifier conformance and 
alignment service (VCAS) ensures that the verifier is internally dust-free, checks 
that it is focused correctly, and adjusts the hardware to account for any change in 
the brightness of the LEDs used to illuminate the barcodes.

This annual service is not the same as user calibration, as it looks at the output of 
the LEDs and corrects for any variance in their evenness of illumination across the 
whole field of view. Over time the LEDs will fade but they will not fade uniformly. 
User calibration ensures that the verifier is measuring the darkest and brightest 
reflectances correctly but it cannot correct for any variance in the illumination.

After your verifier has been serviced, we will return it you with a new calibration 
card, a new user guide and a new certificate of ISO/IEC conformance. You will 
then need to calibrate the verifier before you use it again. The latest software can 
always be downloaded free of charge from our website, www.axicon.com.

e-Cert
Returning a verifier to us for this annual VCAS 
(verifier conformance and alignment service) is 
sometimes difficult, yet the verifier may still be 
operating within its expected tolerances, and 
could be re-certified as being conformant to 
the ISO/IEC standards for barcodes and barcode 
verifiers. Using eCert provides you with the 
reassurance that the barcode verifier is working 
correctly without having to return it to us.

We supply a set of specially produced barcode 
test cards, a new calibration card, and 
instructions about how to use them and upload 
the results to an Axicon web platform. Axicon’s 
technical staff will assess the results, and if the 
verifier passes we will supply you with a new 
certificate of conformance that lasts for one 
year.



Contact us
Axicon Auto ID Ltd 
Church Road
Weston on the Green
Oxfordshire 
OX25 3QP
UK

Tel:  +44 (0) 1869 351 155
Fax:  +44 (0) 1869 351 205
Email:  info@axicon.com
Website: www.axicon.com

As Axicon continually improves its products, their specifications and features are 
subject to change without notice. All trademarks are acknowledged as belonging to 
their respective companies.

Your Axicon distributor


